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Important
1 Copyright © 2004 by Canon, Inc. All rights reserved. The unauthorized transfer of all or

any part of the contents of this manual is forbidden.
2 The contents of this manual are subject to change without notice.
3 Every effort has been made to ensure that content of this manual is free from errors.

If you encounter any errors, omissions or apparent inaccuracies, contact the
manufacturer.

4 Notwithstanding the above, Canon accepts no liability for any results arising from the
operation of this product.

This manual describes how to use the WebView Livescope Ver. 3.6 Viewer Software.
There are two types of viewers, Viewer for Java and the Viewer for PC, and the video
sender can use one or the other as required. Both types provide the same basic
functions for viewing videos, but differ in terms of other features and functions. The
preparations for using the two viewer types and the required operating environment also
differ depending on the computer hardware and software used to run the viewer.
Read this manual carefully before you use the viewer to ensure that you make the best
possible use of this product.
Store this manual in a safe place after you finish reading it.
The latest information on the viewer is available at the following URL.
http://www.canon.com/webview

Introduction

Trademark Information
Canon and Canon logo are registered trademarks of Canon Inc.
Microsoft Windows and Microsoft Internet Explorer are registered trademarks of the Microsoft Corporation in the
United States and other countries.
Netscape is a trademark of Netscape Communications Corporation.
Java and all Java-based marks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United
States and other countries.
All other company or product names used in this document are trademarks or registered trademarks of their
respective holders.
* In this document, “Microsoft Windows” is abbreviated as simply “Windows”.

Conventions

Indicates important notes or restrictions that must be observed when using this product. Always
read these notes.

Indicates additional information or explanations for a procedure. You should read these items.

Copyright Information
Under copyright law, video or still pictures photographed by the viewer cannot be used for any purpose other than
personal enjoyment without prior permission from the copyright holder.

c
Note

e
Tip

Usage Notice of Audio
1. Audio stream may be interrupted according to the performance of your PC and network environment.
2. If you use a proxy server, the audio may be interrupted.
3. If you use a PC on which anti-virus software is installed, the audio may be delayed or the audio stream may be

temporarily interrupted.
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WebView Livescope Overview

■ WebView Livescope is the system that allows camera control and live video distribution from a

remote location.

■ The system is configured for a camera server and viewer software. The camera server distributes

live video taken by the video camera to the Internet or an Intranet. The viewer software can display

the video and remotely control the camera.

■ The WebView Livescope system can be used in a wide range of applications such as distributing

live video from a Web site and monitoring.

The following types of camera servers are available:

• Network Camera Server VB150

• Network Camera VB-C50i/VB-C50iR

• Network Camera VB-C50Fi

The following types of Viewer Software are available:

• Viewer for Java (This manual: provided free of charge with camera server product)

• Viewer for PC (This manual: provided free of charge with camera server product)

• Network Video Recorder VK-64 (Sold separately)

• WebView Livescope MV Ver. 2.1/LE (Sold separately)

■ The names of the viewers have been changed as follows:

Old Name

Helper Viewer

Java Viewer

New Name

Viewer for PC

Viewer for Java

Live

Active

WebView Livescope is a video distribution system that enables users to 
actively (by performing operations by oneself) view live (showing now) video 

from Web pages by allowing users to change camera angle and zoom magnification.

Video Sender
Video Recipient

(Viewer software)
Sending the current video

Viewing by switching angle and zoom magnification

Offers an easy way 
to provide live information contents.

Offers the advantage of 
being able to actively select desirable 

parts from live video according to 
the user’s purposes.

(Camera server)

VB150

VB-C50Fi

VB-C50i
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LiveApplet

Video display functions

Camera control functions

Glimpse

Video display functions

Viewer for Java

Viewer Overview

This is a viewer written using Java. This viewer allows the camera server’s videos to be

viewed on any computer with a Web browser that runs Java, regardless of the platform.

Because the Java applet is downloaded when the viewer starts up, the first video takes

some time to appear. The Viewer for Java provides two types of viewers: LiveApplet

containing video display and camera control functions, and Glimpse containing a video

display function.

Panorama picture

➤

Click

There are two types of WebView Livescope Viewer Software: the Viewer for Java and the Viewer for

PC.

c
Note

● To use the Viewer for Java, you need to install Java VM beforehand. See the

web site for more details.

WebView Product web site            http://www.canon.com/webview

● Panorama pictures must be registered in advance at the camera server.
* Panorama pictures are not available with the VB-C50Fi.
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Viewer for PC

This is a viewer that runs as an application. This viewer provides video display and camera

control functions and appears in a separate window at startup. While the Viewer for PC has

to be pre-installed, it offers the advantage of displaying the first video quickly. At present,

only a Windows version of this viewer is available.

c
Note

● The Viewer for PC is provided on the CD-ROMs supplied with the Network

Camera Server VB150, the Network Camera VB-C50i/VB-C50iR and VB-

C50Fi packages. The viewer can also be downloaded free of charge from

the following web site.

URL : http://www.canon.com/webview

● The Viewer for PC needs to be pre-installed on your computer. (→ p.26)

● Panorama pictures must be registered in advance at the camera server.

* Panorama pictures are not available with the VB-C50Fi.

● When playing back audio, please read carefully “Usage Notice of Audio”

(→ P.4).
* Audio input/output is not available with the VB-C50Fi.

➤

Click

Panorama picture

● Because the Viewer for Java is downloaded from the camera server every

time you access and displays video on the viewer screen, it starts up

slower than the Viewer for PC that is pre-installed on a PC.

● Use the Viewer for Java when you access the camera server and view video

for the first time. However, we recommend you to install and use the Viewer

for PC if you view video frequently.

e
Tip
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Operating Environment

Viewer for Java Ver. 3.6

Viewer for PC Ver. 3.6

Windows 2000 (SP4)/ Windows XP (SP1a or SP2)

Netscape 7.1 or 7.2, 
or Microsoft Internet Explorer 6.0 (SP1 or SP2)

Operating System

Web Browser

* Must be installed in advance from the CD-ROM supplied with the camera server. (→ p.26)

Windows 2000 (SP4)/ Windows XP (SP1a or SP2)

Netscape 7.1 or 7.2, 
or Microsoft Internet Explorer 6.0 (SP1 or SP2)

Operating System

Web Browser

MSVM Release 5.0.0.3810 (Java VM provided by Microsoft)
Java Plug-in 1.4.2 (Java VM provided by Sun Microsystems)

Java VM

* This viewer is installed in the camera server and automatically downloaded when it is connected to the camera 
server.

* Operation is unstable when used with an OS or Web browser other than those noted above.

For the latest information, please refer to our WebView Product web page:

http://www.canon.com/webview
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Viewer for Java
This chapter describes the preparations required for using the Viewer for Java

and explains how to use the viewer.
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Preparations for Using the Viewer for Java

The Viewer for Java is automatically downloaded from the camera server. There is no need to install

it in advance. However, depending on the type of Web browser you are using and your software

settings, you must change your Web browser settings.

Using Internet Explorer

* For Internet Explorer 6.0

Internet Explorer has a setting that specifies whether the use of Java is permitted.

From the “Tools” menu, select “Internet Options” and click the “Advanced” tab. Then set “JIT

compiler for virtual machine enabled” as the “Microsoft VM” setting.

In Windows XP, Java VM may not be installed. If this is the case, please install it. See the

web site for more details.

WebView Product web site            http://www.canon.com/webview

Detailed settings below similar to the ones are displayed after settings.

* For Internet Explorer 6.0
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Using Netscape

* For Netscape 7.1

Netscape also has a setting that specifies whether the use of Java is permitted.

Select “Preferences” from the “Edit” menu, click “Advanced” and then click in the “Enable

Java” checkbox.

The settings for the Web browser vary depending on the version used. Refer

to the settings given here and check your browser version.
c
Note
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When You are Connected to a LAN

If the camera server is used via an Intranet and you specify the Web browser proxy

setting manually, videos are distributed via the proxy. This can result in a slower

frame rate and proxy server overload.

Use the procedure shown below to set up a “No proxy” connection. Note that if

you are accessing a camera server that is located outside a firewall on the internet,

registration is not required for the camera server.

e
Tip

Setup Examples

Using Internet Explorer
Specify either “Automatically detect settings”, “Use automatic configuration script” or “Use

a proxy server for your LAN” below.

● Automatically detect settings

1 From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

2 Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

3 Tick “Automatically detect settings” in “Automatic configuration”.

4 Click “OK” to close the Local Area Network (LAN) Settings dialog box and the Internet

Options dialog box. Proxy data is automatically detected when you specify this setting.

● Use automatic configuration script

1 From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

2 Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

3 Tick “Use automatic configuration script” in “Automatic configuration” and enter the URL

(e.g. http://192.168.100.10/proxy.pac) of the Settings file.

4 Click “OK” to close the Local Area Network (LAN) Settings dialog box and the Internet

Options dialog box.

* For Internet Explorer 6.0

* For Internet Explorer 6.0
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● Use a proxy server for your LAN

1 From the “Tools” menu, select “Internet Options” and click the “Connections” tab.

2 Click “LAN settings” to open the Local Area Network (LAN) Settings dialog box.

3 Tick “Use a proxy server for your LAN” in “Proxy server” and click “Advanced”.

4 In the “Exceptions” field, enter “Camera server IP address: HTTP conversion server

service port”. If there are multiple settings, use a semicolon (;) as the separator (e.g.

192.168.100.1:80;192.168.0.20:80).

5 Click “OK” to close the Proxy Settings dialog box, Local Area Network (LAN) Settings

dialog box and the Internet Options dialog box.

* For Internet Explorer 6.0

Using Netscape
Specify either “Manual proxy configuration” or “Automatic proxy configuration URL” below.

● Automatic proxy configuration URL

1 From the “Edit” menu, select “Preferences”.

2 Select “Proxies” in “Advanced” and select “Automatic proxy configuration URL”.

3 In the “Automatic proxy configuration URL” field, enter the URL (e.g. http://192.168.100.

10/proxy.pac) of the Settings file.

4 Click “OK” to close the Preferences dialog box.

* For Netscape 7.1

Preparations for Using the Viewer for Java



14

● Manual proxy configuration

1 From the “Edit” menu, select “Preferences”.

2 Select “Proxies” in “Advanced” and select “Manual proxy configuration”.

3 In the “No Proxy for” field, enter “Camera server IP address:HTTP conversion server

service port”. If there are multiple settings, use a semicolon (;) as the separator (e.g.

192.168.100.1:80;192.168.0.20:80).

4 Click “OK” to close the Preferences dialog box.

* For Netscape 7.1

Preparations for Using the Viewer for Java
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➤

Starting Up the Viewer for Java

When the “Using Viewer for Java” button in the

Web Browser that displayed the Web page for

distributing videos is clicked, the Viewer for Java

starts up and connects to the camera server.

The Viewer for Java is started up from the Web browser that displayed the Web page for distributing

videos.

To create a Web page for distributing videos, refer to the user’s manual of the camera server you are

using.

Click
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Using the Viewer for Java

“LiveApplet” Screen

There are two types of Viewer for Java (→ p.6). The following is a description of

“LiveApplet”. “LiveApplet” is a viewer with a GUI that allows the user to change the camera

angle, zoom ratio and backlight adjustment settings.

The functions of the GUI displayed on the Web browser are briefly described below.

1

2

3

4

5

Video Source Size Change Buttons
The right-hand button makes the displayed video source one level smoother, while
the left-hand button makes it one level coarser. Making the image coarser increases
the frame rate, while making it smoother improves the video quality.
* Depending on the camera server, the video source size change buttons are not displayed.

Camera Selection Box
When multiple cameras are connected to the camera server, this box can be used to
select the camera.

Tilt Scroll Bar
Used to change the camera tilt angle (up and down movement).
* Not displayed on the VB-C50Fi.

Zoom Scroll Bar
Used to change the zoom ratio.
Moving the button up zooms in (telephoto) and moving it down zooms out (wide-
angle).

Panorama View Button
Displays the pop-up panorama window. Panorama pictures must be saved at the
camera server. Panorama pictures will not be displayed if not saved.
* Not displayed on the VB-C50Fi.

1

2

3

4

5

67891011

Viewer for Java

LiveApplet
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6

7

8

9

10

11

Panorama Window    * Not available with the VB-C50Fi.

You can control the camera by clicking on the panorama window or dragging the yellow

frame on the panorama window.

The black frame indicates the range of

movement for the camera center. The

camera center cannot be moved outside

this frame.

The blue frame indicates the area currently being photographed by the camera.

When you are granted control privileges, this changes to a yellow frame. You can

control the camera pan and tilt by dragging this frame and control the camera

zoom by resizing this frame.

The size of the panorama window may differ from that shown above if field of

view restrictions have been specified on the camera server.c
Note

Camera Control Status Window

Used to display camera control information (“Camera controllable”, “Camera not

controllable”, “Awaiting turn”, “Remaining camera control time”).

Start Control Button

Used to acquire camera control privileges.

Backlight Adjustment Button

Compensates for backlighting. Useful when the video appears dark due to

backlighting. Click the button again to cancel.

Preset Selection Box

Allows you to control the camera by selecting preset camera positions registered

beforehand on the camera server.

Pan Scroll Bar

Used to change the camera pan angle (left and right movement).
* Not displayed on the VB-C50Fi.

Snapshot Button

Shows a snapshot of the currently displayed video frame in a separate window. The

snapshot image can then be printed or saved.
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Starting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, “control privileges” has been
introduced by which only the client who currently holds the control privileges can control the
camera. Backlight adjustment and presets can also only be used when you have control
privileges.

Procedure

Camera Control Status Window
Shows the camera control status.

■ Camera Control Status Displays
The display changes depending on the camera control status.

Camera is not
controlled.

You have
clicked the
[Start Control]
button and the

camera server is being contacted.
This display does not appear if the
camera server responds
immediately.

Awaiting
control privilege
reservation.
The number

beside the person icon shows the
estimated time until control privileges
are granted. However, you may be
granted control privileges before this
number reaches “0” because other
users may cancel camera control or
withdraw from the queue.

1

2

3

4

5

6

Click the [Start Control] button to acquire control privileges.

You have been
granted control
privileges. The
number beside

the clock icon is your period of
exclusive control.

You can retain
control
privileges even
though your

period of exclusive control has
expired. This is because there are
no camera control requests from
other clients.

For some
reason, you
have been
disconnected

from the camera control server, you
could not connect to the camera
control server at startup, or your
connection was not permitted. The
status display panel turns red.

* For the VB-C50Fi.

*

*

*

*

*

*
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Procedure

Controlling the Camera 

Once you have been granted camera control privileges, you have complete control over the

camera angle, the zoom ratio and the backlight adjustment setting.

Move the button on the Pan Scroll Bar  or Tilt Scroll Bar.

The camera angle changes to match the position of the scroll bar buttons.

Tilt Scroll Bar

This scroll bar changes the camera’s

tilt (up or down).

Pan Scroll Bar

This scroll bar changes the camera’s pan (left or right).

By clicking

When you click on the panorama window, the camera pans and tilts so that the place

you clicked moves to the center.

By dragging

When you drag inside the yellow frame on the panorama window to another position,

the camera pans and tilts to shoot the area in the frame.

By clicking a point on the video,
you can move the center of the
camera to that point.

Using the Viewer for Java

Changing the Camera Angle    * Not available with the VB-C50Fi.

■ Changing the Camera Angle on the Panorama Window    * Not available with the VB-C50Fi.
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Procedure

Changing the Camera Zoom Ratio

Move the Zoom Scroll Bar button up or down.

The camera zooms in or out to match the position of the zoom bar button.

Zoom Scroll Bar

Move the button up to zoom in

(telephoto).

Move the button down to zoom out

(wide-angle).

■ Changing the Zoom Ratio on the Panorama Window    * Not available with the VB-C50Fi.

By dragging

When you drag the edge of yellow frame on the panorama window to change the

frame size, the zoom ratio changes accordingly.

If you click outside the frame and drag the mouse while holding the button

down, a blue frame is drawn. When you release the mouse button, the blue

frame turns yellow and the camera pans, tilts and zooms to shoot the area in

the new frame.

e
Tip
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Procedure

Selecting the Camera

When multiple cameras are connected to the camera server, you can switch between

cameras. Click on the Camera Selection Box to view the list of cameras. When you select a

camera from the list of names, the display changes to show the video from that camera.

Camera Selection Box

Procedure

Using Presets

The presets and camera selection options displayed are those set on the

camera server. If no presets or additional cameras are registered on the

camera server, no selection options are shown.

c
Note

Using the Viewer for Java

You can control the camera by selecting preset camera positions (presets) registered on the

camera server.

Click on the Preset Selection Box to view the list of preset positions. When you select a

preset position from the list, the display changes to show the video from that position.

Preset Selection Box
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Procedure

Adjusting Backlight

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight Adjustment] button, video darkened by backlighting becomes

brighter.

Click the button again to cancel.

Backlight Adjustment

Button
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Procedure

● Because a new still picture is captured when you click the camera icon, the

still picture displayed may be fractionally later than the moment you clicked

the icon.

● Under copyright law, video or still pictures photographed by the viewer

cannot be used for any purpose other than personal enjoyment without

prior permission from the copyright holder.

● For Windows XP SP2 users, you may not be able to use the camera icon to

take snap shots. If so, hold down the Ctrl key on the keyboard and click the

camera icon or follow the instructions on the displayed Information Bar to

disable the pop-up blocker.

When you click on the camera

icon, the still picture at the time

you took the snapshot appears in

a new window.

e
Tip

c
Note

Using the Viewer for Java

Printing and Saving a Still Picture
The Viewer for Java does not have functions for printing or saving the video

displayed.

However, you can use the Snapshot function to save and print video as a still

picture.

1 Take a snapshot of the video you want to print or save.

2 Use the Save or Print function in your Web browser to save or print the still

picture.

Taking a Snapshot of the Video

This function allows you to take a snapshot (still picture) of a particular live video.

When you take a snapshot, it appears in a new browser window.
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“Glimpse” Screen

The Glimpse viewer is used only for viewing video; it does not include camera control

functions.

There are two types of Viewer for Java (→ p.6). The following is a description of “Glimpse”.

The “Glimpse” viewer is a light-weight Viewer for Java. It has a short download time as it has

no camera control functions and only displays video images.

This viewer is useful for viewing videos from multiple sites, as shown below.

Viewer for Java

Glimpse

Using the Viewer for Java



Chapter 2

Viewer for PC
This chapter describes the preparations required for using the Viewer for PC

and explains how to use the viewer.
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Preparations for Using the Viewer for PC

Installing the Viewer for PC

The Viewer for PC must be pre-installed on your PC.

For details on installing, please refer to the user’s manual of the camera server you are

using.

● Microsoft Internet Explorer 6.0 SP1 or later must be installed to run the

Viewer for PC. Check that it is already installed before installing the Viewer

for PC (→ p.8).

● If Ver. 3.3 or earlier viewer is already installed, when you try to install the

new version, a dialog box appears asking you if you want to uninstall the

old version. If you want to install the new version, click Yes, and the new

version will be installed after the installer uninstalls the currently installed

Viewer.

● It cannot be installed in a machine in which WebView Livescope MV Ver. 1.0

has been installed.

c
Note

e
Tip

Follow the steps below if you are downloading from the web site and

installing.

1 Download the install file from the web site.

2 Double-click “wvh36.exe”.

3 Follow the instructions on the screen and install. When the setup

completion screen appears, click [Quit].

A short-cut icon is created on the desktop.
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Using Browsers Other Than the Recommended Products

To launch and run the Viewer for PC from a Web browser, the recommended browsers are:

Microsoft Internet Explorer 6.0 (SP1 or SP2), and

Netscape 7.1 or 7.2.

The use of any browser other than these may require some setup measures. If you cannot

launch the viewer after installation, launch the Web browser and register the application. For

information on registering application, refer to the documentation provided with your

browser.

MIME type x-webview-h

Extension wvh

Application

C:\Program Files\Canon\WebView\Viewer\3.60

(default installation folder)

MonView.exe

The application “VBToolsInstall.exe” is installed into the folder

specified for the installation.
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Starting Up the Viewer for PC

The Viewer for PC can be started up in two ways: From the Web browser that displayed the Web site

for distributing videos, or starting it up independently. Normally it is started up from the Web browser.

To create a Web page for distributing videos, refer to the User’s Manual provided on the CD-ROM

enclosed with the camera server package.

Starting Up from the Web Browser

Click the “Using Viewer for PC” or other buttons

on the Web browser that displayed the Web

site for distributing videos . The Viewer for PC

starts up and connects to the camera server.

➤

Starting Up Independently

Double-click the icon created on the

Desktop. It can also be started up by

choosing it from the Start menu:

Start | Programs | WebView

Livescope | Viewer for PC.

No connection to the camera server

(→ p.29) is made when the Viewer

for PC is started up independently.

➤

Double-click

Click
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Connecting to the Camera Server

When you use the Viewer for PC to connect to the camera server and monitor, if the Viewer for PC was
started up from the Web browser, it automatically connects to the camera server. But if the Viewer for PC
was started up independently, you need to specify the camera server or select a registered camera server.
You can also change the connection target to another camera server while you are still connected to one
camera server, or start up multiple Viewer for PCs and connect each one to a different camera server.

Specifying a Connection Target and Connecting

Procedure

1 Choose Connect from the File menu.

2 The “Camera server address settings” dialog box

appears. Enter each item and click OK to make a

connection to the camera server.

■ Host Name
Specify the IP address of the camera server

■ Video connection settings
[Auto] [WV-TCP] [WV-HTTP]
Select whether to connect to the camera server using auto selection, or to connect
using the WebView-TCP or WebView-HTTP protocol. When connecting with auto
selection, the viewer automatically selects the optimum protocol and connects to the
camera server. If you are connecting to the camera server from inside a firewall,
select WebView-HTTP (→ pp.44, 45).
[Video] [Camera Control] [HTTP]
Specify the port numbers of the camera server. These are the values specified on the
camera server. They can normally be used with the default settings.

■ Audio connection
[Receive audio data]
Select to receive audio when audio has been transmitted. (For cameras which have
an audio function.)

Click “Option” to open the “Camera server address settings options” dialog box. Here
you can register sites. Click “OK” to return to the “Camera server address settings”
dialog box.
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Selecting a Registered Camera Server and Connecting

Procedure

Select the connection target from the site selection

box. The camera servers displayed here are sites that

were registered by selecting “Add to camera site list”

when a connection was made by specifying a

connection target, or registered using the “Register

Connected Site button (→ p.39)”.

See p.47 for details on registering or changing a

server.

Disconnecting

Procedure

Choose Disconnect from the File menu, or close the

Viewer window to exit.

c
Note

If you connect to a site containing user access restrictions, you will be asked

to enter a user name and a password. Enter the correct user name and

password to complete the connection. (Refer to the User’s Manual of the

camera server.)

■ Add to camera site list
When this is ticked, camera server information that was entered is registered in the
viewer, and you can view video by simply selecting it from the selection box. Once
ticked, in the “Nickname” field enter the name with which you want to register.

Connecting to the Camera Server
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Using the Viewer for PC

The Viewer for PC provides a GUI that allows you to change the camera angle, zoom ratio and

backlight adjustment settings.

“Viewer for PC” Screen

The functions of the GUI displayed when the Viewer for PC starts up are briefly described below.

1

2

3

4

6

Video Source Size Change Button

The right-hand button makes the displayed video source one level smoother, while

the left-hand button makes it one level coarser. Making the image coarser increases
the frame rate, while making it smoother improves the video quality.

Full Screen Mode Button

Displays the video at full-screen size. Press the [Esc] key to return to the original video size.

Pause/Resume Button

Pauses video during play, or starts play if currently stopped.

Register Connected Site Button

Lets you register a camera site during connection.

Audio Settings Button

Lets you set audio functions.
* Only displayed if the camera is connected to a camera server that supports the Audio function.

Site Selection Box

Lets you connect to a registered camera site by selecting it here.

Camera Selection Box

Can be used to select the camera when multiple cameras are connected to the camera server.

Tilt Scroll Bar

Used to change the camera tilt angle (up and down movement).
* Not available with the VB-C50Fi

1 2 3

7

8

9

10

11

12131415

7

6

8

4 5

5



32

10

11

12

13

14

15

Panorama Window    * Not available with the VB-C50Fi.

You can control the camera by clicking on the panorama window or dragging the yellow

frame on the panorama window.

The black frame indicates the range of

movement for the camera center. The

camera center cannot be moved outside

this frame.

The blue frame indicates the area currently being photographed by the camera
when you do not hold camera control privileges.
When you are granted control privileges, this changes to a yellow frame. This
frame not only indicates the area being photographed by the camera, but you can
also control the camera pan and tilt by dragging the entire frame around and
control the camera zoom by dragging the edge of the frame to change its size.

c
Note

The size of the panorama window may differ from that shown above if field of

view restrictions have been specified on the camera server.

9 Zoom Scroll Bar

Used to change the zoom ratio.

Moving the button up zooms in (telephoto) and moving it down zooms out (wide-

angle).

Panorama View Button

Displays the pop-up panorama window. Panorama pictures must be saved at the

camera server. Panorama pictures will not be displayed if not saved.
* Not displayed on the VB-C50Fi.

Camera Control Status Window

Used to display camera control information (“Camera controllable”, “Camera not

controllable”, “Awaiting turn”, “Remaining camera control time”).

Start Control Button

Used to acquire camera control privileges.

Backlight Adjustment Button

Compensates for backlighting. Useful when the video appears dark due to

backlighting. Click the button again to cancel.

Preset Selection Box

Allows you to control the camera by selecting preset camera positions registered

beforehand on the camera server.

Pan Scroll Bar

Used to change the camera pan angle (left and right movement).
* Not available with the VB-C50Fi.
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Starting Camera Control

Although multiple clients can simultaneously connect to the camera server, multiple clients
cannot simultaneously control the camera. Consequently, “control privileges” has been
introduced by which only the client who currently holds the control privileges can control the
camera. The use of backlight adjustment and presets is also limited to the client who
currently holds the control privileges.

Procedure

Camera control status window
Shows the camera control status.

■ Camera Control Status Displays
The display changes depending on the camera control status.

Camera is not controlled.

Awaiting control privilege
reservation. The number
beside the person icon
shows the estimated time

until control privileges are granted.
However, you may be granted
control privileges before this number
reaches “0” because other users
may cancel camera control or
withdraw from the queue.

You have been granted
control privileges. The
number beside the clock
icon is your period of

exclusive control.

1

2

3

4

5

Click the [Start Control] button to acquire control privileges.

You can retain control
privileges even though
your period of exclusive
control has expired. This

is because there are no camera
control requests from other clients.

For some reason, you
have been disconnected
from the camera control
server, you could not

connect to the camera control server
at startup, or your connection was
not permitted. The status display
panel turns red.

Using the Viewer for PC
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Procedure

Controlling the Camera

Once you have been granted camera control privileges, you have complete control over the

camera angle, the zoom ratio and the backlight adjustment setting.

Changing the Camera Angle    * Not available with the VB-C50Fi.

Move the button on the Pan Scroll Bar or Tilt Scroll Bar.
The camera angle changes to match the position of the scroll bar buttons.
Also, if you click a point on the image, the camera moves so that the point you clicked
becomes the center of the video.

By clicking a point on the video,
you can move the center of the
camera to that point.

Tilt Scroll Bar

This scroll bar changes the camera’s

tilt (up or down).

Pan Scroll Bar

This scroll bar changes the camera’s

pan (left or right).

■ Changing the Camera Angle on the Panorama Window    * Not available with the VB-C50Fi.

By clicking

When you click on the panorama window, the camera pans and tilts so that the place

you clicked moves to the center.

By dragging

When you drag inside the yellow frame on the panorama window to another position,

the camera pans and tilts to shoot the area in the frame.
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Procedure

Changing the Camera Zoom Ratio

Move the Zoom Scroll Bar button up or down.

The camera zooms in or out to match the position of the zoom bar button.

Zoom Scroll Bar

Move the button up to zoom in (telephoto).

Move the button down to zoom out (wide-

angle).

■ Changing the Zoom Ratio on the Panorama Window    * Not available with the VB-C50Fi.

By dragging

When you drag the edge of yellow frame on the panorama window to change the frame

size, the zoom ratio changes accordingly.

If you click outside the frame and drag the mouse while holding the button

down, a blue frame is drawn. When you release the mouse button, the blue

frame turns yellow and the camera pans, tilts and zooms to shoot the area in

the new frame.

e
Tip

Using the Viewer for PC
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c
Note

Procedure

Selecting the Camera

When multiple cameras are connected to the camera server, you can switch between cameras.

Click on the Camera Selection Box to view the list of cameras. When you select a camera from

the list of names, the display changes to show the video from that camera.

Camera Selection Box

Procedure

Using Presets

You can control the camera by selecting preset camera positions (presets) registered on the

camera server.

Click on the Preset Selection Box to view the list of preset positions. When you select a preset

position from the list, the display changes to show the video from that position.

Preset Selection Box

The presets and camera selection options displayed are those set on the camera

server. If no presets or additional cameras are registered on the camera server,

no selection options are shown.
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Procedure

Changing the Video Source Size

If multiple video source sizes are specified on the camera server, these buttons can be used to

select the size used for display. Changing the video source size does not change the size of the

video displayed.
* The effects of the Video Source Size Change Button may not be reflected in all camera servers or settings.

Procedure

Using Full-Screen Mode

You can use this function to view the video displayed at full-screen size. If you click the [Full-
Screen Mode] button and then click [OK] in the confirmation dialog box that appears, the video

appears at full-screen size. To revert to the

original video size, press the [Esc] key. If you
click the right mouse button while in full-screen

mode, a pop-up menu

appears from which

you can choose to

return to the original

video size or pop up

the panorama window

on the current video.

Makes the video source one level coarser (faster frame rate).

Makes the video source one level smoother (better video quality).

Using the Viewer for PC
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Procedure

Adjusting Backlight

Backlight adjustment is useful when the video is dark due to backlighting.

When you click the [Backlight Adjustment] button, video darkened by backlighting becomes

brighter.

Click the button again to cancel.

Backlight Adjustment Button

Procedure

Pausing and Restarting Video Display

Video can be paused or restarted. Click the Pause/Restart button. Video can also be paused on the

menu that is displayed when you right click the mouse on the viewer screen. To resume, right click

the mouse and select “Resume Paused Picture”.

“Pause Picture Display” to stop video

display and “Resume Paused Picture” to

restart the paused video display.
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Menu-based Operations

All the functions accessed via buttons can also be accessed from the menu

bar. Functions that can only be accessed from the menu bar are discussed on

the following pages.

* See p.47 for details on using the Camera Site List.

Procedure

Registering a camera site during connection

By registering a camera site during connection, subsequent connections to that site become

easy. The camera site currently connected can be registered by clicking the [Register

Connected Site] button. Registered camera

sites are displayed in the Site Selection box

and can be connected to by simply selecting

them. Registered camera sites can also be

changed or deleted (→ p.48).

e
Tip

Using the Viewer for PC
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e
Tip

Procedure

Saving Still Pictures to Files

When the video you want to save appears, click the [Pause/Resume] button.
The video is displayed as a still picture.

Select “Save” from the “File” menu.
When it ends, the video is resumed when you click the [Pause/Resume] button.

Saving and Printing Still Pictures
You can save and print snapshots of live video you want to retain.

1

2

Saved File Formats
Files are saved in BMP format.
Saved still pictures can be viewed using a Web browser or image display software.

c
Note

Under copyright law, video or still pictures photographed by the viewer
cannot be used for any purpose other than personal enjoyment without prior
permission from the copyright holder.

Procedure

Playing back audio

Click [Audio settings] and configure the audio data sent from the camera server (For cameras
which have an audio function).

Play back the audio data: If this setting is ticked, and audio has been transmitted, the audio is
played back.
Volume slide bar: Adjusts the volume.
Mute: If this setting is ticked, the volume is turned off.

e
Tip

Even if the audio is played back, it will stop if the Viewer is minimized.

c
Note

When playing back audio, please read carefully “Usage Notice of Audio” (→
P.4).

* This function cannot be used if the camera is connected to a camera
server that does not support audio.



V
iew

er for P
C

2

41

Using the Viewer for PC

Procedure

1

2

3

Printing Still Pictures

When the video you want to print appears, click the [Pause/Resume] button.

The video is displayed as a still picture.

Select “Print” from the “File” menu.

Specify the print settings.
To change the printer settings, click the
[Setup] button.

When you have finished printing, click the [Pause/Resume] button to restart video
display.

Setting Details

Print position Specifies the print position for the image.

Print camera 
information

Ticking this checkbox prints camera parameters such as the pan 
and tilt angles with the image.

Displaying Information

Dialog boxes can be displayed that show the video, connection and camera information. To view
this information, select “Video Information”, “Connect Information”, “Camera Information” or
“Network” from the “View” menu.

Video Information

● Frame rate
Received frame rate

● Size
Data capacity per frame

● Captured image size
Height and width of the video data being
received

● Compression type
Server’s video compression method
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Connection Information

● Protocol
WebView-TCP or WebView-HTTP

● Video [WV-TCP]
IP address of camera server:port number

● Camera control [WV-TCP]
IP address of camera server:port number

● Video/Camera [WV-HTTP]
IP address of camera server:port number

● Proxy
Proxy usage information

● Local time
Local time on the camera server (GMT)

Camera Information

● Pan
Current camera pan angle

● Tilt
Current camera tilt angle

● Zoom
Current camera zoom (viewing angle)
value

● BackLightMode
Current backlight adjustment ON/OFF
status

● CameraModel
Model of the camera

Network

● Indicator (camera mark)
Video data network band

● Indicator (speaker mark)
Audio reception network band
* Not displayed if Audio is not connected.

● Restrict video data
You can control the video data band traffic.

Using the Viewer for PC



Chapter 3

Viewer for PC Settings
This chapter describes how to specify the software environment settings for

the Viewer for PC.
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Procedure

“Starting protocol” Setting

Select “Setup Properties” from the “View” menu.

Viewer for PC Settings

From the “Setup Properties” window, you can specify a range of settings governing the operation of

the Viewer for PC. Normally, there is no need to alter these settings.

1

2

Specify whether connection to the camera server is to be made using the WebView-TCP

protocol or the WebView-HTTP protocol.

● “Auto select connection”
Use this setting when you do not know
the details of the connection
environment. When this option is
selected, the viewer first tries to connect
using WebView-TCP and then tries

WebView-HTTP.

● “WV-TCP protocol connection”
This setting uses the WebView-TCP
protocol used specifically by WebView
for TCP connections. To penetrate
firewalls with this protocol, a dedicated

application gateway is required.

Viewing video from behind a firewall
To view video from behind a firewall using the WebView-HTTP protocol, you
must specify the HTTP proxy settings. You can set the same settings as the
HTTP proxy specified in your Web browser. If you want to access video from
behind a firewall, select WV-HTTP protocol. (See P.45 for details.)

● “WV-HTTP protocol connection”

This setting uses the WebView-HTTP protocol, which is the WebView protocol that conforms

to the ordinary HTTP standard. The HTTP proxy can be used as is and the firewall can be

passed.

● “Receive audio data”

Remove the tick if you do not want to receive audio data.

c
Note

Select protocols from the “Options at starting with WVH file” in the “Starting protocol” tab.
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Procedure

“HTTP protocol” Setting

Select “Setup Properties” from the “View” menu and then select the “HTTP protocol”

tab.
1

2

Specify these settings when you are connecting using the WebView-HTTP protocol.

You can use asterisks (*) as wildcards in the host name in the “Set hosts not

using proxy.” setting. This allows you to specify multiple host names at once.

(Example)

192.168.100.*

Hosts with an IP address that begins with “192.168.100.” do not use the proxy.

*.webview.co.jp

Hosts on the network with the “webview.co.jp” domain name do not use the

proxy.

■ Use automatic configuration script
Tick if you want to use the automatic configuration script. Once ticked, enter the URL
of the Settings file in the “Address” field.

■ Use WV-HTTP proxy
[WV-HTTP proxy server]
Tick if you want to use an HTTP that uses a proxy. This then allows you to penetrate
firewalls. Once ticked, enter the domain name or IP address of the HTTP proxy
server host in the “Host” field, and enter the port number in the “Port” field.
[Do not use the proxy for local hosts]
Tick if you want to connect to local addresses without using the proxy.
[Set hosts not using proxy]
You can set up servers that can be accessed without using a proxy, not to use a
proxy. In this field, enter the domain name or IP address of the host that does not
use a proxy. To specify multiple hosts, use a comma (,) to separate the
specifications.

e
Tip

Enter each item. To automatically

import Internet Explorer HTTP proxy

settings, click “Acquire IE proxy

settings”.
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Procedure

“Display option” Setting

Select “Setup Properties” from the “View” menu and then select “Display option”.

Select “Set video display size used at startup”.

1

2

Use this setting to specify the size of the video displayed at startup. Note that the opening

screen shown at startup is displayed at an image size of 320 × 240.

● “Adjust to default image size”

When you connect to the server, the viewer starts up with the image size matched

to the image size initially sent.

● “Use a display size in list below”

Allows you to select any of 4 sizes: Large, Middle, Small and Minimum.

e
Tip

The image size varies according to the type and settings of the connected

camera server.

NTSC PAL

Large 640 × 480 768 × 576

Middle 320 × 240 384 × 288

Small 160 × 120 192 × 144

Minimum 80 × 60 96 × 72

Viewer for PC Settings
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Registering and Changing the Server

The camera server can be registered beforehand and thereafter you can access the server simply by

selecting it from the registered servers. The procedures for registering and changing camera server

are described below.

Procedure

Adding to a list

The camera server can be registered during connection by clicking the “Register connected

site” button or choosing “Register Site” in the File menu. If the site is currently not

connected, it can be registered following the procedure below:

Choose “Camera Site List” from the

“View” menu. When the camera site list

appears, click Add.

■ Nickname
Any name can be given to the camera server being registered.

■ Host Name
Specify the IP address of the camera server.

The “Setup camera site” dialog box

appears. Enter each item and click “OK”

to add a camera server to the list.

1

2

Registering in a Camera Site List
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Make the changes. Click “OK” to activate the

changes.
2

Procedure

Changing or deleting registration details in the list

Choose “Camera Site List” from the “View”

menu, and select the registered camera site

that you want to change or delete.

If you want to make changes in the details,

click Edit. To delete a site, click Delete.

1

■ Video connection settings
[Auto] [WV-TCP] [WV-HTTP]
Select whether to connect to the camera server using auto selection, or to connect
using the WebView-TCP or WebView-HTTP protocol. When connecting with auto
selection, the viewer automatically selects the optimum protocol and connects to the
camera server. If you are connecting to the camera server from inside a firewall,
select WebView-HTTP (→ pp.44, 45).
[Video] [Camera Control] [HTTP]
Specify the port numbers of the camera server. These are the values specified on
the camera server. They can normally be used with the default settings.

■ Receive audio data
Remove the tick if you do not want to receive audio data.
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While a camera site is selected, you can

move it to a different position in the list by

clicking the Up or Down button. This order is

reflected in the list displayed in the Site

Selection dialog box.

3

Registering and Changing the Server



Appendix
Messages displayed in the viewers are explained in this section.
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Error Messages

Message

Details

Solution

too many clients

The limit on the number of video server connections has been exceeded.

Access to the camera server is apparently overcrowded. 
Wait some time and then reconnect.

Situation At connection

Message

Details

Solution

can’t connect
version mismatched

The camera server is a different version.

Clear the Web browser cache.

Situation At connection

Message

Details

Solution

can’t connect

The viewer cannot connect to the camera server.

There is a coding error in the Web page used for video distribution, 
or there is a problem on the camera server. Check with the administrator of the video 
distribution Web page.

Situation At connection

Viewer for Java Error Messages

Message

Details

Solution

couldn’t get camera control

The limit on the number of people queuing for camera control privileges has been 
exceeded.

Access to the camera server is apparently overcrowded. Wait some time and then 
try again to acquire control privileges.

Situation During camera control privileges acquisition

Message

Details

Solution

camera control is disabled

The viewer cannot connect to the camera control server.

This is normal operation because camera control is prohibited by the camera server.

Situation At connection
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Viewer for PC Error Messages

Message

Details

Solution

No response from video server.

The viewer could not connect to the video server.

There is a coding error in the Web page used for video distribution, or there is a 
problem on the camera server. Check with the administrator of the camera server.

Situation At connection

Message

Details

Solution

Network is busy. Please try again later.

The limit on the number of video server connections has been exceeded.

Access to the camera server is apparently overcrowded. Wait some time and then 
try again to acquire control privileges.

Situation At connection

Message

Details

Solution

No response from camera control server. You can use video only.

The viewer could not connect to the camera control server.

This is normal operation because camera control is prohibited by the camera server.

Situation At connection

Message

Details

Solution

camera is off-line or abnormal

The connected camera is switched off or the RS cable is not connected.

There is a problem with the camera server (with the camera power supply or the 
RS cable connection). Check with the administrator of the camera server.

Situation At connection

Message

Details

Solution

disconnected

The connection time limit has expired or the connection was cut due to restart 
processing on the camera server.

To reconnect, reload (refresh) the Web page in your Web browser.

Situation At disconnection
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Message

Details

Solution

Couldn’t get camera control privileges.

The limit on the number of people queuing for camera control privileges has been 
exceeded.

Access to the camera server is apparently overcrowded. 
Wait some time and then reconnect.

Situation At connection

Message

Details

Solution

You do not have video server access privileges.

There is a restriction applied in the camera server settings that limits the IP 
addresses of clients allowed to connect.

This is normal operation. This situation is set up by the camera server administrator.

Situation At connection

Message

Details

Solution

Camera switched off or faulty.

The connected camera is switched off or the RS cable is not connected.

There is a problem with the camera server (with the camera power supply or RS 
cable connection).

Situation At connection

Message

Details

Solution

Invalid WVH file.

There was an error in the information in the WVH file.

There is a coding error (WVH file) in the Web page used for video distribution, or there 
is a problem on the camera server. Check with the administrator of the web page.

Situation At connection

Message

Details

Solution

Disconnected

The connection time has expired or the connection was cut due to restart processing on 
the camera server.

Restart your Viewer for PC.

Situation At disconnection

Message

Details

Solution

Audio connection not possible

Audio connection not authorized on the server side, or the device does not have an 
audio connection function.

Check with the camera server administrator.

Situation At connection

Error Messages
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